WorkstationST* Service
Instruction Guide

These instructions do not purport to cover all details or variations in equipment, nor to provide for every possible contingency to be met during installation, operation, and maintenance. The information is supplied for informational purposes only, and GE makes no warranty as to the accuracy of the information included herein. Changes, modifications, and/or improvements to equipment and specifications are made periodically and these changes may or may not be reflected herein. It is understood that GE may make changes, modifications, or improvements to the equipment referenced herein or to the document itself at any time. This document is intended for trained personnel familiar with the GE products referenced herein.

Public – This document is approved for public disclosure.

GE may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not provide any license whatsoever to any of these patents.

* Indicate s a trademark of General Electric Company and/or its subsidiaries. All other trademarks are the property of their respective owners.

For further assistance or technical information, contact the nearest GE Sales or Service Office, or an authorized GE Sales Representative.

Revised: June 2017
Issued: June 2006


We would appreciate your feedback about our documentation. Please send comments or suggestions to controls.doc@ge.com
Document Updates

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tools Menu</td>
<td>Updated the figure <em>Tools Menu Items</em> to include new menu options, <em>System Workstation Consumed Device Information</em> and <em>View System IP Address Information</em>, and added those items to the list of menu options</td>
</tr>
<tr>
<td></td>
<td>Added the section <em>System Workstation Consumed Device Information</em></td>
</tr>
<tr>
<td></td>
<td>Added the section <em>View System IP Address Information</em></td>
</tr>
</tbody>
</table>

Acronyms and Abbreviations

- **EGD**: Ethernet Global Data
- **HMI**: Human-machine Interface
- **M&D**: Maintenance & Diagnostic
- **OSM**: On Site Monitor
- **SDI**: System Data Interface
- **UOSM**: Universal On Site Monitor
- **UPC**: Universal Product Code
Safety Symbol Legend

**Warning**
Indicates a procedure or condition that, if not strictly observed, could result in personal injury or death.

**Caution**
Indicates a procedure or condition that, if not strictly observed, could result in damage to or destruction of equipment.

**Attention**
Indicates a procedure or condition that should be strictly followed to improve these applications.
Control System Warnings

Warning

To prevent personal injury or damage to equipment, follow all equipment safety procedures, Lockout Tagout (LOTO), and site safety procedures as indicated by Employee Health and Safety (EHS) guidelines.

Warning

This equipment contains a potential hazard of electric shock, burn, or death. Only personnel who are adequately trained and thoroughly familiar with the equipment and the instructions should install, operate, or maintain this equipment.

Warning

Isolation of test equipment from the equipment under test presents potential electrical hazards. If the test equipment cannot be grounded to the equipment under test, the test equipment’s case must be shielded to prevent contact by personnel. To minimize hazard of electrical shock or burn, approved grounding practices and procedures must be strictly followed.

Warning

To prevent personal injury or equipment damage caused by equipment malfunction, only adequately trained personnel should modify any programmable machine.

Warning

Always ensure that applicable standards and regulations are followed and only properly certified equipment is used as a critical component of a safety system. Never assume that the Human-machine Interface (HMI) nor the operator will close a safety critical control loop.
## Contents

1. Introduction ........................................................................................................... 6
2. WorkstationST Features ......................................................................................... 6
   2.1 Alarms .................................................................................................................. 6
   2.2 Live Values .......................................................................................................... 7
   2.3 Historians ............................................................................................................. 7
   2.4 Network Time Protocol (Time Synchronization System) ....................................... 7
   2.5 Network Status Monitor ...................................................................................... 8
   2.6 On Site Monitor (OSM) ....................................................................................... 8
   2.7 HMI Configuration .............................................................................................. 8
3. WorkstationST Configuration and Monitoring ....................................................... 9
4. Start and Stop WorkstationST Service ................................................................. 9
5. Configuration Files Data Flow .............................................................................. 10
6. Binding EGD Data ................................................................................................. 11
7. WorkstationST Status Monitor ........................................................................... 11
   7.1 Multi-language Support ...................................................................................... 12
   7.2 File Menu ............................................................................................................ 12
   7.3 Tools Menu ......................................................................................................... 13
   7.4 Options Menu ..................................................................................................... 24
   7.5 Start and Stop WorkstationST Features ............................................................ 24
   7.6 Status Monitor Shortcut Menu ........................................................................... 25
   7.7 Right-click Menu ............................................................................................... 32
8. On Site Monitor ..................................................................................................... 33
9. Glossary of Terms ................................................................................................. 34
1 Introduction

The WorkstationST* Service provides an interface for downloading the ToolboxST* configuration to a workstation, and ensures that configured WorkstationST Features start and stop accordingly. It also provides access to control and diagnostic information for the WorkstationST Features, as well as historical Alarm and Recorder data.

2 WorkstationST Features

WorkstationST features include:

- Alarms
- Live data values
- Historians
- Network Time Protocol (NTP)
- Network Status Monitor
- On Site Monitor (OSM)
- HMI configuration tools

2.1 Alarms

Alarm Server monitors and optionally historically logs alarms (process alarms, events, holds) from controllers (Mark* V1e, Mark V1eS, Mark Ve or Mark VI). It also monitors diagnostic events from controllers and Mark V1e I/O packs. Optionally, the alarm server can be configured to consume alarms from external OPC® AE servers to allow third-party alarm content into our system.

OPC AE Server provides access to external OPC AE clients to view the alarms and events that are available in the Alarm Server feature.

Alarm Viewer is a client to the Alarm Server to provide access to live alarms and events, and access to the optional historical log of alarms and events. The viewer has built in filtering and statistical analysis in the form of pareto charts and transition and frequency summary tabular views.

Note For more information, refer to the following documents:

- WorkstationST Alarm Server Instruction Guide (GEI-100626)
- WorkstationST OPC AE Server Instruction Guide (GEI-100624)
- WorkstationST Alarm Viewer Instruction Guide (GEI-100620)
2.2 Live Values

**OPC DA Server** provides access to external OPC DA clients for live data values. The CIMPLICITY* viewer is configured as an OPC client to this server to provide live data to CIMPLICITY screens. OSI® PI is configured with an OPC DA client to store live data with the historian feature (WorkstationST V03.02 and later). Proficy Historian is also configured with an OPC DA client to store live data with the historian feature (but it uses the WorkstationST V04.00 and later). The OPC DA server has an optional OPC DA client that can provide live data access to external OPC DA servers. For more information, refer to the *WorkstationST OPC DA Server Instruction Guide* (GEI-100621) and the *WorkstationST CIMPLICITY Advanced Viewer Integration Instruction Guide* (GEI-100697).

**OPC UA Server** provides access to external OPC UA clients for live data values. Additionally it provides access to historical data in the local Historian and Recorder from configured OPC HDA Historians. The OPC UA server has an optional OPC UA client that can provide live data access from external OPC UA servers. Refer to the *WorkstationST OPC UA Server Instruction Guide* (GEI-100828).

**Modbus®**(V03.02 and later) with serial and Ethernet connections and both Master and Slave is provided. Refer to the *WorkstationST Modbus Instruction Guide* (GEI-100696).

The WorkstationST computer can be configured to produce EGD exchanges. EGD variables are currently from three sources:

- External OPC DA server variables accessed from the WorkstationST OPC DA server’s OPC DA client feature
- WorkstationST owned OPC DA variables driven by any external OPC DA client
- Modbus variables from external masters or slaves

2.3 Historians

**Recorder** provides access to live collections at up to frame rate periods. Variables can be configured in the ToolboxST application to be collected by the Recorder.

The following data can be automatically uploaded to files that can be viewed using the Trender:

- Trip logs
- Capture blocks in controller logic and Dynamic Data Recorder (DDR)
- Triggerable collections in the controller

**Historian** configures the target historian (OSI PI or Proficy*) to collect data from the OPC DA server. For OSI PI or Proficy historians, the WorkstationST component provides access through OPC HDA to the Trender to view the history of collected variables.

**Note** For further information, refer to the following documents:

- *WorkstationST Recorder Instruction Guide* (GEI-100627)
- *Trender for the ToolboxST Application Instruction Guide* (GEI-100795)
- *WorkstationST Historian Instruction Guide* (GEI-100628)

2.4 Network Time Protocol (Time Synchronization System)

Network Time Protocol (NTP) can be configured to serve NTP to the control system. It can be configured to use a network time card or follow an external black box network time server. Configuration for syncing to a site time source is available. For further details, refer to the *ControlST Software Suite How-to Guides* (GEH-6808), the chapter *How To Configure Time Synchronization in the ToolboxST Application*. 
2.5 **Network Status Monitor**

Network Status Monitor is a feature that can be configured by the ToolboxST application to monitor managed switches on the UDH or PDH network and provide status information in the system overview. Each device is monitored through Internet Control Message Protocol (ICMP) ping, in addition to the status of each port of each managed switch. Alarms are generated and available to live and historical clients of the Alarm Server.

2.6 **On Site Monitor (OSM)**

OSM provides access to the OSM to Mark VIe/Mark Ve control's live unpublished data.

2.7 **HMI Configuration**

WorkstationST V03.02 and earlier provides an importer to synchronize a CIMPLICITY project’s point configuration database, measurement systems, resources, alarm classes, and alarm points with the ToolboxST configuration. This feature is also available in the WorkstationST application V03.03 and later, but is not the preferred method for getting CimView screens to display live data and view alarms.

WorkstationST V03.03 and later, in conjunction with the CIMPLICITY V7.5 or later, provides an OPC client feature of CimView that allows the CimView screens to access live data and variable configuration information directly from the WorkstationST application's OPC DA server. In addition, the WorkstationST application provides CimView screens with added right-click features for adding variables to trends, viewing variable live values, and configuration. This includes the ability to force a variable, alarm states, and forced state of variables on a CimView screen and some drag-and-drop access to the CimEdit application. This allows ToolboxST logic to be linked with CimEdit graphic symbols, so that dragging objects from the ToolboxST controller logic editor onto CimEdit screens (for example, dragging of a motor operated value from logic to a CimEdit screen) can result in a working, linked graphic symbol.

---

**Warning**

Logic forcing procedures can result in personal injury or death, if not strictly followed. Only adequately trained personnel should modify any programmable machine. Forcing of control logic for an operating process is strongly discouraged. Forcing of protective functions is never permissible for an operating unit. All safety measures should be strictly enforced in conjunction with this procedure.

---

8 GEI-100623M WorkstationST Service
For public disclosure
3 WorkstationST Configuration and Monitoring

System Data Interface (SDI) Command and Live Data Connections are used by the WorkstationST Service. The WorkstationST Service responds to requests for control, status, download and file upload through the SDI command connection. When the ToolboxST application connects to the WorkstationST runtime software, it uses this SDI command connection to obtain WorkstationST feature status, as well as the SDI live data connection (made to the OPC server). Live data for the historical system (Recorder) and for the alarm system (Alarm Server) are obtained through this SDI connection. The live data connection obtains the current live data values of a WorkstationST-monitored variable. The OPC server must be enabled to obtain live values.

4 Start and Stop WorkstationST Service

When the WorkstationST Service is started, the configuration is read from the folder containing the last WorkstationST configuration. The configuration includes a list of external devices that communicate with this workstation through Ethernet Global Data (EGD).

When the configuration is downloaded, an internal WorkstationST message is sent to all configured WorkstationST Features notifying them of the download. When the download is complete another message is sent. An EGD consumed data file is built by binding the EGD data obtained from the EGD Configuration Server (or from the actual device if the device is Class 3, and online).

When the WorkstationST Service is stopped, all configured WorkstationST Features are also stopped.

Note Since the WorkstationST Service is the main communication portal to ToolboxST features, the ToolboxST application can only restart it from a remote computer, if the remote computer has service start/stop remote access authorization.
5 Configuration Files Data Flow

The WorkstationST service receives downloads of WorkstationST configuration from ToolboxST. The configuration is stored to the local configuration where it is available for use by WorkstaionST features. Other device configuration is described below.

* Each feature reads other device EGD configuration from the following sources:
  - Other Device is EGD Class 2 or lower:
    - EGD Configuration Server
    - Local Cache
  - Other Device is EGD Class 3 or higher:
    - Directly from the device
    - EGD Configuration Server
    - Local Cache
6 Binding EGD Data

The WorkstationST Service binds the EGD configuration as part of the download. The download from the ToolboxST application includes a bound EGD consumed-data file, but the WorkstationST Service attempts to rebind the configuration. By doing this, if the ToolboxST application has a stale configuration for any EGD device, the freshest configuration is used.

In addition to a ToolboxST download, the OPC server can request a configuration update if it sees an exchange signature change from a component. Mark Vle and Power Conversion components map their application revision onto an EGD exchange. These revisions are compared against the previous revision, and found in a configuration extension in the EGD Symbol table. A difference in this revision triggers the OPC server to request new configuration data from the WorkstationST application.

7 WorkstationST Status Monitor

The WorkstationST Status Monitor provides status and control of the WorkstationST features on the local computer. The Status Monitor is included in the Status tab in the Component Info View of the configured WorkstationST component.

The WorkstationST Status Monitor is configured to start when you log on to Windows®, and then runs as a tray icon. When a warning or error occurs with the WorkstationST Service or any configured feature, the appropriate icon displays.

➢➢ To monitor and configure WorkstationST features: from the taskbar notification area, double-click the Status Monitor icon.

---

[WorkstationST Status Monitor Feature Status table]
7.1 Multi-language Support

Beginning with the ControlST* V04.03, the Status Monitor can be displayed in the local Windows language.

Prior to enabling this feature, the following prerequisites apply:

• Windows Language Pack must be installed or the operating system is in the native language
• Status Monitor resource DLLs that match the selected Windows display language must be installed

Resource DLLs can be created or modified using the Resource Translation Manager utility and exporting the strings to a dictionary text file for translation. This application is automatically installed when the Configuration Tools Package or WorkstationST application is installed. The Resource Translation Manager utility can be found in the Resource Translation Manager folder, which is located within the GE Energy install folder (default install location is `C:\Program Files (x86)\GE Energy\Resource Translation Manager`). For instructions to create resource DLLs, refer to the Resource Translation Manager User Guide (GEI-100793).

**Note** The Status Monitor does not support languages that read right-to-left.

➢➢

To display the Status Monitor in the local Windows language

1. From the Start menu, select Control Panel and Region and Language.
2. From the Region and Language dialog box Display Language tab, select Keyboards and Languages.
3. Select a language.

**Note** For further details, refer to the ControlST Software Suite How-to Guides (GEH-6808), the chapter How to configure a Second Language for ControlST HMI Applications.

7.2 File Menu

The File menu allows the user to open the local folder where the WorkstationST log files are stored. It also provides the option to Save and Zip all feature logs.
7.3 Tools Menu

The Tools menu provides the following options:

- **Time Convert Utility**
- **View Registered OPC Servers**
- **Certificate Manager**
- **View EGD Configuration Differences**
- **System Workstation Consumed Device Information**
- **View System IP Address Information**

### 7.3.1 Time Convert Utility

The Time Convert Utility menu option converts configuration times from EGD .xml files to actual dates and times. It also converts numeric values to Universal Time Coordinated (UTC) dates and times. Unsigned integer seconds since 1970 are converted to a date and time, then converted back to seconds since 1970.

➢➢ To convert configuration values to dates and times: from the Tools menu, select Time Convert Utility.

Enter the information to be converted and press Enter. The conversion displays to the right.

### 7.3.2 View Registered OPC Servers

The View registered OPC Servers menu option allows the user to view all OPC UA, OPC DA and OPC AE servers that are registered on the computer.

➢➢ To view registered OPC servers: from the Tools menu, select View registered OPC servers.

The List of registered OPC Servers from host localhost window displays the registered servers.
7.3.3 Certificate Manager

The Certificate Manager menu option, which requires Administrator privileges, manages the security certificates in the Windows LocalMachine\UA Applications store. The certificates are required by the OPC UA server and the client to create secure connections to other servers and clients. For details on the connection sequence between an OPC UA server and the client, refer to the WorkstationST OPC UA Server Instruction Guide (GEI-100828).

➢ To reissue a certificate: from the Tools menu, select Certificate Manager.

To reissue a certificate:

1. From the Tools menu, select Certificate Manager.
2. Select a certificate from the list (such as UA Local Discovery Server) and from the toolbar, click Reissue.
3. Enter the new lifetime of the certificate and click OK.
➢ **To import or export a certificate**

1. From the *WorkstationST Certificate Manager* dialog box, select the certificate.
2. From the toolbar, click **Import** or **Export**.
3. If Import is select, you are prompted to add the certificate to the computer’s trust list.

![Import Certificate to Trust List](image)

Click **Yes** to accept the certificate.

➢ **To delete a certificate**: from the *WorkstationST Certificate Manager* dialog box, select the certificate, then click **Delete** on the toolbar.

➢ **To assign a certificate to an application**: from the *WorkstationST Certificate Manager* dialog box, select the certificate, then click **Assign** on the toolbar.

![Assign a Certificate to an Application](image)

From the Application dropdown list, select **GeCssOpcUaServer** or **GeCssOpcUaClient**.

**Note** This certificate is used when the assigned OPC UA server or client makes a secure connection.
7.3.4 View EGD Configuration Differences

The View EGD Configuration Differences menu option displays the differences between the local EGD configuration files (WorkstationST cache) and the EGD Configuration Server files. The local cache remains equal to all running component configurations. It is updated once controllers are downloaded.

➢➢ To view EGD configuration differences: from the Tools menu, select View EGD Configuration Differences.

The Local Configuration (Local WorkstationST Cache) Compare to Server Configuration window display the comparison results between the local WorkstationST EGD configuration files and the files that were last published to EGD Configuration Server.

---

**EGD Configuration Differences**

**EGD Configuration Commands**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Local Document</td>
<td>Views the local version of a selected document</td>
</tr>
<tr>
<td>View Server Document</td>
<td>Views the server version of a selected document</td>
</tr>
<tr>
<td>Refresh Display</td>
<td>Compares the local system to the EGD configuration server and updates the display</td>
</tr>
</tbody>
</table>
7.3.5 System Workstation Consumed Device Information

The System Workstation Consumed Device Information menu option provides a report of live data consumption and alarm consumption viewed by WorkstationST, consumed devices, or as text.

➢➢ To create a Workstation Consumed Device Information report: from the Tools menu, select Workstation Consumed Device Information.

There are several tabs available for the user to view consumption. These report views are detailed in the following sections:

- Live Data Consumption
- Alarm Consumption
- View by Consumed Devices
- View as Text

Live Data Consumption View

The default selection is Live Data Consumption. The following figure shows the direct consumption over EGD and the proxy consumption through another workstation for various controllers in a control system. For example, the Alarm_Primary workstation consumes the BOP controller directly, G1 and G2 through HMI_Block1, and G3 and G4 through HMI_Block2.
WorkstationST Alarm and Live Data Consumption Information

Live Data Consumption View
Alarm Consumption

By selecting the *Alarm Consumption* tab, the direct alarm consumption for controllers on the local UDH is displayed, as well as the remote alarm consumption through other workstations. For example, BOP alarms are consumed directly by `Alarm_Primary`, G1 and G2 alarms are consumed through `HMI_Block1` as a primary connection and through `HMI_Block1b` as a secondary connection. Likewise, alarms for G3 and G4 are consumed by `HMI_Block2` primary and `HMI_Block2b` secondary.
View by Consumed Devices

By selecting the View by Consumed Devices tab, the controller devices with child nodes are displayed indicating their consumers. For example, by selecting the Live Data Consumption tab, G1 is shown consumed by HMI_Block1 and HMI_Block1b, and additionally consumed indirectly through HMI_Block1 by Alarm_Primary, Alarm_Secondary, and HMI_Block2.
By selecting the *Alarm Consumption* tab from this view, G1 is shown consumed by HMI_Block1, and HMI_Block1b, and indirectly through HMI_Block1 by Alarm_Primary and Alarm_Secondary, and through HMI_Block2 by Alarm_Primary and Alarm_Secondary.
View as Text

Select the View as Text tab to view a text report of consumption that can be saved to a file representing the consumption configuration.
7.3.6 View System IP Address Information

The System IP Address Information report provides a report of WorkstationST device names, host name, network name, and IP address.

➢ To create a System IP Address Information report: from the Tools menu, select View System IP Address Information to display the report.

Example System IP Address Information Report
7.4 Options Menu

➢ To display features and documentation that may not be translated

![Options Menu](image)

From the **WorkstationST Status Monitor Options menu**, select **Enable Non-Translated Content**.

![Enable Non-Translated Content](image)

Click **OK** to enable the non-translated content.

*Note* For additional information, refer to the section *Multi-language Support*.

7.5 Start and Stop WorkstationST Features

➢ To start or stop WorkstationST features

1. From the taskbar notification area, double-click the **Status Monitor** icon.

2. Right-click the desired feature and click **Start** or **Stop** from the **Status Monitor shortcut menu**.

Start and stop requests are sent to the WorkstationST Service. When the WorkstationST Service starts, it attempts to start all configured features, and to keep the features running. If a feature is stopped from the Status Monitor, WorkstationST Service will not attempt to restart it. If the feature is started again from the Status Monitor (or WorkstationST Service is restarted), the feature starts again.
7.6 Status Monitor Shortcut Menu

Shortcut menu options include:

- Start Selected Feature(s)
- Stop Selected Feature(s)
- View Additional Status Detail
- View OPC UA Connection Information
- View NTP (Time Sync) Detail
- Copy Selected
- Advanced

*Note* If the *Selected sub features to start* dialog box displays, select the sub features and click OK.

### 7.6.1 View Additional Status Detail Option

➢➢ To display additional status information: double-click the tray icon. Right-click the **Feature** and select **View Additional Status Detail**.

The WorkstationST Service runs a System Data Interface (SDI) server. The Status Monitor uses an SDI client to obtain the information displayed. Information is not available when the WorkstationST Service is not running.

With the release of the ControlST V04.00, two new features have been added to the OPC DA server's additional status dialog box: Display Live Values and Display Connection Information. These features are available from the toolbar.

The OPC DA server provides live data to OPC DA and SDI clients and consumes data from various live data sources.
When the Alarm Server is selected from the WorkstationST Status Monitor, the server status displays. Select the Configuration tab to display the Alarm Server Configuration status.
Select the **Alarm Sources** tab to display the connections and their status.

Select the **CAM Connections** tab to display the CIMPLICITY Alarm Manager (CAM) Connections status.

Select the **Client Connections** tab to display the Alarm Event Clients status.
Select the **Alarm Queues** tab to display alarm queue information from the Alarm Server.

Click any ellipsis button to display information for the selected queue.

---

**Alarm Status Viewer File Menu Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Server Hostname</td>
<td>Hostname on the local computer (default) that has the Alarm Server enabled</td>
</tr>
<tr>
<td>Save Status to Text File</td>
<td>Allows user to save the current Alarm Server status to a text file</td>
</tr>
</tbody>
</table>
7.6.2 View OPC UA Connection Information Option

This menu option displays the OPC UA connection information for the selected feature.
7.6.3 View NTP (Time Sync) Detail Option
This option displays time synchronization information and is accessible when any feature in the status monitor list is selected.

![NTP Status Viewer](image)

**NTP Status Viewer File Menu Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify Remote Host</td>
<td>Allows user to display NTP service status on a remote computer (the local computer is the default display)</td>
</tr>
<tr>
<td>Data Logging</td>
<td>Allows user to log the Status Viewer’s data to a log file</td>
</tr>
</tbody>
</table>

![Data Logging](image)

7.6.4 Copy Selected Option
This menu option allows you to copy the selected WorkstationST Status Viewer list to the clipboard for future use.
### 7.6.5 Advanced Option

#### Advanced Menu Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Detail Log</td>
<td>Allows user to display detailed events for the selected feature</td>
</tr>
<tr>
<td>Save and Zip all feature logs</td>
<td>Allows user to save configured log files to a specified zip archive</td>
</tr>
</tbody>
</table>

![Log Data Display](image-url)
7.7 Right-click Menu

➢ To display the right-click menu options: from the taskbar notification area, right-click the Status Monitor icon.

<table>
<thead>
<tr>
<th>Item</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privileges Log On</td>
<td>Replace the current user or temporarily override the current user</td>
</tr>
<tr>
<td>Privileges Log Off</td>
<td>Log off the current user</td>
</tr>
<tr>
<td>Show Current Privileges User</td>
<td>display the current user and their assigned privileges</td>
</tr>
<tr>
<td>Regional Settings</td>
<td>Provides two options:</td>
</tr>
<tr>
<td></td>
<td>• Use Second Language displays the Status Monitor in the designated second language.</td>
</tr>
<tr>
<td></td>
<td>• Select Active Measurement System (Metric) to select the measurement system used by operator facing features such as Trender (the measurement system currently in use displays in parentheses).</td>
</tr>
<tr>
<td>Open Detail View</td>
<td>Displays the WorkstationST Status Monitor: Feature Status screen.</td>
</tr>
<tr>
<td>Exit</td>
<td>Exit the Status Monitor (the tray icon no longer displays)</td>
</tr>
</tbody>
</table>

**Right-click Menu Option Functionality**

Note: Privileges are modified from the System Information Editor only.

For more information, refer to the following documentation:

• WorkstationST/CIMPLICITY Advanced Viewer Integration Instruction Guide (GEI-100697), the section Privileges.

• ControlST Software Suite How-to Guides (GEH-6808), the chapters How to configure a Second Language for ControlST HMI Applications and How to Define a Measurement System for Use by ControlST HMI Applications.
8 On Site Monitor

The On Site Monitor (OSM) feature supports the Universal On Site Monitor (UOSM). The UOSM is a stand-alone computer that serves as a gateway to the customer’s system data, which is used by GE’s Maintenance and Diagnostic (M&D) group to detect and diagnose system problems.

The OSM collects system configuration data from the WorkstationST Config Reader and writes data files for the UPC (Universal Product Code), which communicates with the M&D group. The OSM provides realtime data using the OPC DA server. It displays in the Component Editor of the WorkstationST component.

**Note** The OPC Server feature must be set to *True* before the OSM can be enabled.

The OSM should only be enabled on a UOSM computer.

➢ To enable OSM: from the **WorkstationST Component Editor General** tab **Tree View**, select **Features**, and set **On Site Monitor** to **True**
9 Glossary of Terms

**Bind**  To establish the correspondence between the data in an exchange and variables in a device.

**Bind/Build**  To bind the configuration for each consumed exchange and create/update the configuration for any produced exchange.

**Collection**  More formally, an EGD Collection. A group of devices that constitutes a formal subset of the devices participating in a particular EGD installation. This arbitrary grouping allows users to subdivide the system to make some tasks easier.

**Consume**  To receive an EGD data message (exchange).

**Consumer**  An EGD node configured to receive an EGD data message.

**EGD**  A control network and communication protocol; a mechanism that provides access to global data between nodes supporting the EGD protocol.

**Exchange**  An EGD data message consisting of a header and a body of data. The header contains the producer ID and the exchange ID that uniquely identifies the message. The body of data is a block of bytes in a format agreed upon by the producer and all consumers.

**Feature**  An element of the WorkstationST runtime system, which can be optionally enabled through the ToolboxST application. Examples include OPC server, Recorder, and Alarm Viewer.

**Global Data**  A concept in which multiple controllers on a network can share information by exchanging portions of their local memory with peer controllers.

**OPC**  A standard for data exchange in the industrial environment. The OPC foundation provides specifications for various OPC standards such as OPC DA (Data Access) and OPC AE (Alarm and Event).

**Produce**  To send an EGD data message (exchange).

**Producer**  The EGD node configured to send data messages. The source of the data samples for an exchange.

**Refresh**  To bind the configuration for each consumed exchange for a particular consumed device.

**Runtime**  Software stored in the controller’s Flash memory that converts application code (pcode) to executable code.

**Unbound Variables**  Variables required by a consumer that were not found in the producer configuration during the bind.